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Introduction
For over two and a half decades, Minnetonka Audio has been delivering exceptional technology to discerning professionals. In recent years, subjective management of loudness has become
the center of attention for media consumers and legislators alike. Minnetonka Audio’s AudioTools
product line answers the call for easy to use, file–based loudness management.

AudioTools FOCUS & Loudness Control
AudioTools FOCUS for Loudness Control provides a subset of AudioTools Server applied specifically to file–based loudness management. This allows the user to focus on presets rather than
program details. Since media types and program configurations are handled transparently, the
product is designed to deliver exceptional results without the need to customize Job parameters. If
customization is called for, new presets can be defined easily and deployed quickly.
AudioTools FOCUS for Loudness Control contains highly tuned audio processing workflows,
each one addressing a particular loudness control requirement. With greater–than–realtime processing of PCM, MXF and QuickTime, AudioTools FOCUS for Loudness Control intelligently
creates dynamic content that meets all international specifications while retaining the excitement
viewers expect. AudioTools FOCUS for Loudness Control also works with all common loudness
management specifications, and program configurations of up to 8 channels.
AudioTools FOCUS for Loudness Control:
- Manages loudness while preserving artistic intent
- Automates the process of insuring loudness control
- Maintains compliance with CALM, EBU & other international loudness standards
- Eliminates distracting & repetitious “mixing to target”
- Reduces manual intervention when preparing or QC’ing content
- Leverages the expertise of MASI’s A.I.M. processing
Using the industry standard Windows 7 platform, AudioTools FOCUS for Loudness Control is a
stand–alone island of processing expertise in your video universe.

• AudioTools FOCUS for Loudness Control
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Installation
AudioTools FOCUS for Loudness Control is installed with the aid of a standard Setup Wizard.
Before installing, be sure that you are logged in to an account with administrator privileges. Then,
quit all open applications and temporarily disable and anti–malware measures you may have running. Once installation has completed, you can re–enable your anti–malware packages.

Installing the application
You have been provided with a copy of the AudioTools_FOCUSInstall EXE file. Double click
on the EXE file to launch the Setup Wizard. The Wizard will guide you through the installation of
AudioTools FOCUS.

The AudioTools FOCUS Setup Wizard

After accepting the End–User License Agreement, you are prompted for an installation directory. The default directory location is usually appropriate. Choose the directory, then click on the
Install button to allow the Setup Wizard to guide you through the process.

WIBU installation
The AudioTools FOCUS family relies on the WIBU CodeMeter licensing framework, which is
automatically installed by the Wizard. As the Setup Wizard nears completion, you will be presented
with a dialog that says, “If your CodeMeter USB Device is not, connected, please connect now.”

The CodeMeter reminder dialog
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This is a reminder that you will need a licensed CodeMeter USB dongle to run AudioTools FOCUS for Loudness Control. Click OK.
If your host computer already has WIBU licensing installed, you may receive a warning saying,
“CodeMeter SDK is already installed on this machine…” If this occurs, click on the OK button,
which will warn that the CodeMeter installation did not complete. Then, click on the Finish button
to allow the FOCUS Setup Wizard to complete the installation process. You should check that you
have the most recent CodeMeter software installed before proceeding

Completing AudioTools FOCUS installation

Licensing & Activation
Activation

AudioTools FOCUS requires a properly authorized CodeMeter dongle to operate. You may have
received a pre-authorized CodeMeter dongle. If this is the case, simply insert the CodeMeter dongle into an available USB port and AudioTools FOCUS will open and run. If you did not receive a
pre-authorized CodeMeter dongle, follow the steps below to authorize AudioTools FOCUS.

Generating your License Request file

In the Windows Start Menu > All Programs > CodeMeter, select “CodeMeter Control Center.”
This launches the CodeMeter Control Center application.

! ��������

Note that, if the CodeMeter Control Panel application does not immediately come to the front, go
to the Windows taskbar and click on the “CodeMeter Control Center” icon.

The CodeMeter Control Center

If you have not yet inserted your CodeMeter dongle into an available USB port, please do so now.
• AudioTools FOCUS for Loudness Control
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Selecting the dongle to authorize

In the left side of the CodeMeter Control Panel is a list of all CodeMeter dongles attached to the
system. Select the CodeMeter dongle which you wish to authorize, then click the “License Update”
button next to the CodeMeter dongle list.

The CodeMeter License Update welcome screen
Page 8
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Click on “Next,” then select Desired Action.

Choosing to create a license request file

Select “Create License Request,” then select “Next.”

Selecting your license request option

Select the “Add license of a new producer” request file option.
• AudioTools FOCUS for Loudness Control
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IMPORTANT: If you have never authorized a Minnetonka Audio Software product on this dongle,
select “Add license of new producer.” If you have already authorized a Minnetonka Audio Software
product on this dongle, select “Extend existing license.”

Entering the Firm Code

Enter the Firm Code for Minnetonka Audio Software. Unless you have been otherwise notified
by your Minnetonka Audio Software representative, the value to enter is “101391”.
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Specifying a license request file name

Select a location and name for the license request file. Remember this location and file name
because you will need to send this file to Minnetonka Audio Software. The Desktop is a convenient
location and the default file name is a good choice.
Once you have specified a location and file name, select “Commit.”

Completing activation
• AudioTools FOCUS for Loudness Control
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If the license request was successfully generated, select “Finish.”

Sending the License Request File

E–mail the License Request file you just generated in the previous steps to <activations@MinnetonkaAudio.com>. You will receive a reply within 48 business hours.

Activating License Response

When you receive the license response e–mail from Minnetonka Audio, there will be an attachment with the extension “.WibuCmRaU”. THIS IS YOUR LICENSE UPDATE FILE! Save this file to
the hard drive of the machine you wish to activate. Double-click this file. The license will be downloaded to the CodeMeter stick from which the license request was generated.

Permissions
AudioTools FOCUS includes a Windows Service that runs in the background. A Windows
Service, by default, runs under a special account owned by the operating system. When installing,
you should check that the Service has the proper permissions. This is only necessary if you will be
accessing directories that require you to enter your user name and password to gain access. Before
proceeding, you may want to check with your IT or Help Desk department for the correct setup.
Configuring the AudioTools Service
1) In Control Panel, click on Administrative Tools, and then click on Services. Or, in
the Start Menu, search for “services.msc” and click on the search result.

Searching for the Services utility

2) Once in the Services utility, scroll through the list of Services to locate the “MASI
AudioTools Service”. Double click on that service or right–click and select Properties.
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3) In the Server Properties dialog, select the Log On tab.
4) Select “This account” and enter the account that you want the Service to use. If
your company uses Active Directory or other Directory Services, you may need to
“Browse…” to locate your account.

Entering your account credentials in the Services utility

5) Enter and confirm the password for your account.
6) Click OK to exit the Server Properties dialog.
7) Close the Services utility.

Uninstallation
Uninstalling Audio FOCUS

To uninstall AudioTools FOCUS and all of its components, go the Windows Start Menu > Control Panel > Programs and Features. In the resulting list, locate the entry for AudioTools FOCUS.
Select the AudioTools FOCUS entry and click “Uninstall.”

• AudioTools FOCUS for Loudness Control
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Loudness Regulation
Why Loudness?
To quote the ATSC’s A/85 Recommended Practice: Techniques for Establishing and Maintaining
Audio Loudness for Digital Television, “Consumers do not expect large changes in audio loudness
from program to interstitials and from channel to channel. Inappropriate use of the available wide
dynamic range has led to complaints from consumers and the need to keep their remote controls at
hand to adjust the volume for their own listening comfort.”
To address complaints, both the EBU and ATSC have recommended that broadcasters move
from a peak normalization to a loudness normalization paradigm, where the gain of all content is
adjusted prior to playout so as to maintain a constant subjective loudness rather than a simple peak
amplitude. Loudness is a far more complex issue than simple amplitude. Being a psychoacoustic
phenomenon, it is dependent on power, frequency and duration. All these factors are processed in
our brains to create our perception of “loudness.”

Measuring Loudness
This section reviews the concepts, terminology, and measurement methods that have been defined and adopted worldwide to manage the subjective loudness of broadcast material. These standards were based on thorough testing using real people, not just mathematical models.

LKFS

The EBU and ATSC have adopted well defined standards for objective measurement of amplitude that correlate well with perceived loudness. Along with the new standards, a new methodology for measurement was defined by the ITU; LKFS or K–weighted loudness referenced to digital
full scale. A well established measurement scale is dBFS, on which LKFS is based. dBFS measures
amplitude, in decibels, and is used in most digital audio workstations (DAWs) today. Zero dBFS
is assigned to the maximum possible digital amplitude that can be captured, and is defined as all
available bits, whether 16, 24 or 32 in AES/EBU data words being “filled” with valid data.
The dBFS measuring method itself is frequency–blind so, to adapt dBFS to measure and correlate
to subjective loudness, that needed to change. The result is the newly developed frequency–dependent LKFS measurement process. LKFS is very different from older PPM, VU and proprietary
legacy amplitude measuring systems such as Dorrough meters.
LKFS incorporates the following measurement steps:
a) High frequencies are boosted 4 dB with a shelving filter having a 3 dB point at ≈2
kHz
b) Low frequencies are attenuated with a 2nd order high pass filter, with a 3 point at
≈60 Hz
c) RMS power for each of the five main channels in the file is derived
d) The two rear channels are gain compensated by +1.41 dB to slightly increase their
contribution
e) The result of the previous power measurements for each channel are summed to
derive a final LKFS value
Of a standard six channel “surround” file, the five main channels are measured. The LFE or Low
Frequency Effects channel is not included in measurements. The K weighting, or the K in LKFS,
refers to the high boost and low shelving mentioned above. Do not confuse K weighting with the
unrelated and proprietary K–System metering method. K weighting’s high shelf mimics the acoustical effects of our head, while the low cut mimics our reduced acuity at low frequencies. The temporal power averaging, spectral shaping that favors higher frequencies and discounts lower frequencies, and spatial weighting that boosts rear channel content incorporated into the LKFS standard
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correlates quite well with what our ear/brain combination perceives as “loudness.”
As with older ad hoc and published industry standards that establish a nominal signal amplitude
defined as a reference level, the EU mandates -23 LKFS while -24 LKFS is the reference level for
North America; 23 or 24 decibels below LK Full Scale. This specified reference level is referred to as
“Target Loudness.” As a point of reference, an in–phase stereo 1 kHz sine wave at 18 dBFS reads at
-18 LUFS absolute on an EBU mode loudness meter. However, since LKFS is frequency dependent,
this can only be used as a very rough “rule of thumb” when mixing in the era of constant loudness.

Gating

Our brain is quite good at adjusting to varying sound pressure changes over time. We can adapt
to a wide range of soundscapes, from a low amplitude outdoor background mix of mild wind and
insect noises, to an orchestral crescendo heard from the sixth row. In order to better measure subjective loudness with only simple calculations, the EBU found that really quiet audio needs to be
ignored. This is accomplished with a “gate,” as in noise gate. A gate can be thought of as a garden
gate that is open under normal conditions, letting everything pass though unimpeded. When the
audio amplitude falls below a pre–defined threshold the gate closes, cutting off the passage of audio.
So, material around the reference level passes through the gate, but very quiet material is excluded.
In the EBU’s measurement regime, which applies to all loudness management practices worldwide, there are two cascaded gating processes. The first, dubbed “absolute gating,” excludes all values below -70 LKFS from the measurement. This suppresses dead air and low level noise. After the
-70 gate is applied, a second “relative” gating process is applied. As specified in ITU-R BS.1770-2,
relative gating excludes all measurements that are more than 10 dB below the RMS or mean loudness. If the mean loudness after absolute gating is, say, -19 LKFS, then all values below -29 LKFS are
removed from the loudness range evaluation. This relative gating is used to remove “atypical” parts
of the signal that are too quiet to draw our attention.

Additional Parameters

Once a weighted LKFS value has been measured, further temporal or time–based integration is
applied to derive additional parameters:
EBU Loudness Parameters:
- Programme Loudness
- Loudness Range
- True-Peak Level
- Momentary Loudness
- Short–Term Loudness

Programme Loudness

The principal loudness parameter is Programme Loudness, also known as Integrated Loudness,
which describes the loudness for an entire program, whether it is a 10 second bumper, a 15 minute
infomercial, or a 140 minute feature film. Programme Loudness, being a measurement derived
from LKFS, uses a related unit; LUFS or Loudness Units relative to Full Scale. It’s a matter of semantics, but think of LKFS and LUFS as conceptually interchangeable, though the EBU recommends using LUFS.

Loudness Range

Loudness Range, or LRA, is also measured in Loudness Units and is basically the dynamic range
of an entire program as seen through the lens of an LKFS measurement. Specifically, it is measured
as the difference between the 5TH and 90TH loudness percentiles. As an example, suppose you have
a quite typical 30 second commercial or “interstitial,” as the standards documents call them. AudioTools FOCUS for Loudness Control measures that content with a resulting LRA of 1.8 LU. That
tells you that there was slightly less than 2 dB of range from the loudest LKFS value measured to the

• AudioTools FOCUS for Loudness Control
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quietest. No wonder commercials are often perceived as loud!

True-Peak

The True-Peak measurement method was developed to address inconsistent or unreliable measurements made with standard sample peak meters, also known as “quasi–peak” or QPPM, as
found in all DAWs and digital recorders today. The disparity between a QPPM and a True–Peak
reading is often 2 or 3 dB and can be more than 6 dB. Inaccurate measurements sometimes lead to
overloads, clipping and distortion when a signal passes through an analog–to–digital converter or
ADC in the listener’s home. The problem is most apparent for highly amplitude–compressed audio
sampled at the baseband rates of 44.1 or 48 kHz.
A True–Peak meter overcomes the inability for low sample rate audio to accurately account for
signal changes between sample snapshots. In other words, they account for signal excursions in
between ticks of the sample clock. Since a sampled signal cannot encode information at other than
the sampling interval, any changes to the signal amplitude during those moments of “blindness”
are not recorded.
However, with a bit of mathematical sleight of hand, that information between samples can be
faithfully estimated and measured. This allows True–Peak meters to provide an accurate gauge
of how an ADC will behave in the real world. The worldwide standard for maximum permissible
True–Peak Level is -2 dBTP, or 2 dB below 0 LKFS when measured with a True–Peak meter.

Momentary Loudness

The Momentary Loudness metric integrates a 400 msec. overlapping “window” that slides along
the audio time line; short enough to ignore the long term trends that our brain largely pays attention to, while still able to capture common transient events like percussive attacks and other events
that may either grab our attention or greatly annoy us. As mentioned above, Momentary Loudness
is weighted.

Short-Term Loudness

A 3 second overlapping and sliding window is integrated to produce a Short–Term Loudness
value. Three seconds is a relatively long time period, and provides a good indication of the loudness
trend of the material. Short–Term Loudness is also weighted. The Maximum Momentary and Maximum Short–Term Loudness values, when used together, are ideal for manging short form content
like commercials.

Supported standards
AudioTools FOCUS for Loudness Control supports North American, EU, Japanese and Australian loudness management standards, including;
ITU-R BS.1770-1
ITU-R BS.1770-2/3
ATSC A/85:2013
EBU R 128 2010
ARIB TR-B32
OP-59

Anchoring
The final aspect of loudness measurement that may need a bit of explanation is the anchor element. AudioTools FOCUS for Loudness Control provides two choices; program or dialog.
Because our brain is highly tuned to speech recognition, we tend to pay attention to dialog when
it is present in an audio track. In the absence of speech, our attention reverts to the music and
effects in the track. AudioTools FOCUS for Loudness Control optionally uses the Dialogue Intelligence algorithm to evaluate the amount of dialog present in a file, which allows the measurement to
“pay attention” to a threshold amount of dialog just as our brain does.
None of the various standards mentioned in the previous section mention dialog anchoring;
Page 16
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they are “dialog–blind.” So, strict interpretation of the standards requires this same approach. In
AudioTools FOCUS for Loudness Control you have a choice, enabling you to use whichever method
produces the optimal result.

• AudioTools FOCUS for Loudness Control
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Getting Started
The Quadrants
Upon first launching AudioTools FOCUS for Loudness Control, you are presented with a user
interface divided up into four Quadrants. Starting at upper right, in counterclockwise order, they
are labeled PRESETS, WORKBENCH, PRODUCTION and PRESET DETAILS. Let’s look at each
Quadrant in turn…

Presets

The PRESET Quadrant contains Factory Presets as well as any user presets created during operation. The Factory Presets are grouped under FOCUS Presets, while the user presets are grouped under User Presets. Clicking on the plus (+) symbol to the left of each preset group or double clicking
on the preset group expands the group to show its members. The plus changes to a minus symbol (-)
when the list is expanded, and clicking on the minus symbol or double clicking collapses the group
list again.

The PRESETS Quadrant

Factory Presets

The presets that are included during installation are either measurement–only, grouped under
Loudness Measurement, or measure and adjust. The latter presets are grouped under Loudness
Adjustment.
The Factory Presets are:
Loudness Adjustment
- Long Form
CALM A/85 Program Anchor
CALM A/85 Dialogue Anchor
EBU Dialog Anchor
EBU Dialogue Anchor
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ARIB Program Anchor
ARIB Dialogue Anchor
OP-59 Program Anchor
OP-59 Dialogue Anchor
- Movies
Loudness Range Adjustment
- Short Form
CALM A/85
EBU R 128
ARIB
OP-59
Loudness Measurement
Stereo File Based
Stereo Watch Folder
Stereo Watch Folder (Mono Files)
5.1 File Based
5.1 Watch Folder
5.1 Watch Folder (Mono Files)
5.1+2 File Based
5.1+2 Watch Folder
5.1+2 Watch Folder (Mono Files)
LOUDNESS ADJUSTMENT PRESETS

The Long Form presets are for general use. When in doubt, use a long form preset. There are
four pairs of long form presets, two for each loudness control standard. Each pair has a dialog–anchored and program–anchored variant. If there is significant dialog in the material, consider using
a dialog–anchored preset. For repeat clients or shows that use the same basic audio format, you may
want to run a test with both anchoring methods to see which method produces better control while
maintaining intelligibility.

! ��������

Note that strict compliance with any of the four broadcast loudness standards dictates using a program–anchored preset as the standards do not include any mention of dialog anchoring.

The Movies preset is a special case designed to control loudness while subjectively preserving the
typically wide dynamic range that modern motion picture soundtracks contain. If the track is derived from a analog optical print or some other source where the dynamic range is already severely
limited, then it is best to use a short form preset. If the track has not already been reduced in dynamic range, this preset will produce subjectively better results than a long form preset.

! ��������

Note that applying the Movies preset will not produce strictly compliance with any of the four
broadcast loudness standards.

The Short Form presets are also special case settings designed for content that has short duration, usually with reduced Loudness Range. Aggressive dynamic range reduction and limiting is often applied to commercials and other content. Unlike the long form presets, the Short Form presets
employ Maximum Momentary and Maximum Short–Term to better manage this class of content.

! ��������

Note that applying the Short Form presets may not produce strictly compliance with your local
broadcast loudness standards. There are subtle variations in local standards for short form material.
Please check with local regulators to establish a short form preset that is aligned with your national
standards.

• AudioTools FOCUS for Loudness Control
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LOUDNESS MEASUREMENT PRESETS

The measure–only presets are divided up by their input or Job type; Watched folders for stereo,
5.1 or 5.1 plus stereo source files. These measure–only presets will measure and save the results, providing a fast and easy way to generate a log or, to be able to inspect the measured results in order to
decide which adjustment preset to use.

User–Defined Presets

All user–defined presets will appear under this heading once you save your first user preset. Be
sure to give your presets a meaningful name, with a syntax that supports easy visual sorting and
identification months or years from now. Saving user presets will be discussed in the section below.

Workbench

The upper left Quadrant is the WORKBENCH. This is the area where presets are instantiated,
modified, saved and launched.

The WORKBENCH Quadrant

Double–clicking on a preset or, dragging one from the PRESETS Quadrant into the WORKBENCH Quadrant will create a new default Job instance. The above figure shows a single default
Job. Each Job instance has five features; a Job type icon at upper left, a Source file picker, an Output
picker, a Save Preset… button, and a Start button at right.
Clicking on a Job instance selects it, changing it’s color from gray to orange. Selected Job instances can be started or removed via the Workbench menu. You can also save all existing Job
instances in the Workbench with the Workbench > Save Workbench… command. The Load
Workbench… command restores a previously saved Workbench state, with all its instantiated Jobs.
Doing so will remove all existing Jobs. A warning dialog prevents accidental deletions.
Dragging a preset onto an existing Job instance will cause the application to ask, “Are you sure
you want to replace the selected Workbench Job with this preset?” Clicking Yes will overwrite the
existing Job instance and create a new default instance of the preset.
The Workbench has a small dot outside the frame at lower right, highlighted in the Workbench
figure above. This dot is the Splitter, a control that allows you to resize all four Quadrants simultaneously. Simply click on and hold the Splitter, then drag it diagonally to change the balance of
screen real estate given to each Quadrant. The View > Focus On menu also lets you expand any
Quadrant to emphasize it or, you can reset the Quadrant layout with the View > Focus On > All
command.
Jobs in AudioTools FOCUS for Loudness Control can be classified into two types: Watch Folder
or File–Based.

Job Types

This section discusses how source files are fed to AudioTools FOCUS for Loudness Control. As
long as your user account has access/permission to read and write a files and/or directory, then they
can be either local or remote. As with any other application performing remote file writes, Au-
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dioTools FOCUS for Loudness Control’s throughput will benefit from higher performance storage
protocols and systems. Again, user permissions apply so, check directory properties before starting
a Job. See “Permissions” on page 12 for more information about access control settings during
installation.
WATCH FOLDERS

Watch Folders are directories that the application monitors for new additions. When new files
are written to a Watch Folder, AudioTools FOCUS for Loudness Control automatically opens the
files and begins processing according to the Job logic that you have defined. This is a “first in–first
out” process, as AudioTools FOCUS for Loudness Control processes serially, one file at a time. If
two or more Jobs define the same directory as their Watch Folder, all of those Jobs will process files
in that Watch Folder.
FILE DRIVEN

File–driven Jobs are straightforward in that you specify a file, and that file or all members of a
multichannel stem are processed directly. This is immediate Job processing, as opposed to the on–
demand function of a Watch Folder Job.

Selecting the Job type

In each Job instance in the Workbench, there is a Job Type menu in the upper left corner. The
menu looks something like a button, with a purple or teal icon on it. Clicking on the icon pops up
the Job Type menu.

The Job Type menu

When you first instantiate a Job, it defaults to a File–based surround Job type, and the Job Type
button displays a purple dog eared document icon. Clicking on the button pops up a menu, allowing you to select a Watch Folder Job type, or a File–Based Job type.
INTERLEAVED OR SPLIT MONO INPUTS

Jobs can accept either individual split mono multichannel file sets, or interleaved multichannel
files that contain all channels in the one file. The first two Job types apply to interleaved multichannel files. The second two Job type variants, additionally labeled Mono Files, are for split mono
multichannel file sets.

Selecting the input

Once the Job type is specified, the Job input must be chosen. For File–based Jobs, click on the
Source file… button just to the right of the Job Type button. This opens a standard file browser,
allowing you to choose your source file(s). Notice that, by default, the Source File name field to the
right of the input select button contains the message, “Click ‘Source File…’ to load a file…”. After
you have specified a source, that field will contain the source file’s name and explicit path.
For Watch Folder Jobs, the input select button’s name changes to Watch folder… Click on the
Watch folder… button to opens a standard file browser. Choose your watched directory. Notice that,
by default, the Watch Folder name field to the right of the input select button contains the message,
“Click ‘Watch Folder…’ to select a Watch Folder…”. After you have specified a source, that field will
contain the watch folder’s name and explicit path.

• AudioTools FOCUS for Loudness Control
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Note that there is no mechanism to prevent two different Jobs from using the same Watch Folder
as input. There are cases where this will cause undesirable results so, it is recommended to create a
unique set of “INPUT” and “OUTPUT” directories within a unique parent directory for each Job that
you create.

Selecting the output

Once the Job source has been specified, the Job output directory must be chosen. To do this,
click on the Output button just below the Source File button. This also opens a standard file browser, allowing you to choose your output directory. That directory must have read/write permissions
set. Notice that, by default, the Output Directory name field to the right of the Output button
contains the message, “Click ‘Output…’ to select an Output Location…”. After you have specified an
output directory, that field will contain the output directory’s explicit path.
The final step is optional; naming and saving the Job as a preset. If you would like to do this,
simply click in the Preset name field to the left of the Save Preset button, then Typing in a descriptive name for this preset. Clicking on the Save Preset button saves your new preset under User
Presets in the PRESETS Quadrant.

Production

Now that you can instantiate Jobs as well as define and save presets, you are ready to start your
Jobs. The PRODUCTION Quadrant contains the Production Queue, with Jobs past and present.

New Jobs

A color–coded Start button occupies the far right of each Job instance. Clicking on it will launch
that Job into the Production Queue, and an instance of the Job appears in the PRODUCTION
Quadrant. In the upper left corner of each Job is a color–coded icon keyed to the Job type.
If it is a File–Based Job, Processing commences. The explicit path of the source file is displayed
along the top of the Job, along with the preset’s name.
If it is a Watch Folder Job, it waits for source files to be added to the watched (source) folder. As
with File–Based Jobs, the explicit source path is displayed along the top of the Job, along with the
preset’s name.

Additional Job features
TRANSPORT CONTROLS

Running Jobs display standard “transport controls” to Stop, Pause and Run that Job. The running Job’s Status Window displays the status, including “Queued,” “Running,” “Completed” and
“Error.” If the Job encounters some difficulty, it will display “FAILED.”
SELECTING & REMOVING JOBS

As with instantiated presets, clicking on a queued Job selects it, changing it’s color from gray to
orange. Each queued Job has a Remove button. Clicking on the Remove button deletes it from the
Production Queue. The Production Queue menu also offers control over Jobs in the Production
Queue. Via the menu, selected Jobs or all Jobs can be stopped or removed. Queued Jobs must be
stopped before they can be removed from the Production Queue.
LOGS

Each queued Job has a Show Log button at far right. Clicking on this button opens the Log. Log
windows display a simplified version of the log generated by each Job. A more detailed or “verbose”
log file is available via preferences, discussed in the next section. The Log window has a Save Log…
button at lower left. This will open a standard file save dialog, allowing you to name and save the
XML–formatted log file. Be sure to give the log file a meaningful name for future reference. Though
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you can open an XML file in any text editor, a dedicated XML editing application, such as the open
source XML Copy Editor, provides some extra conveniences.

Setting Preferences

It is recommended that you check the default settings in the preferences dialog before putting
AudioTools FOCUS into production. The File > Preferences command opens the Preferences dialog.

The Preferences dialog

There are six settings at the top of the dialog:
Automatically delete Source Files on Success
Remember processed Hot Folder sources
Remove from Workbench on Start
Process Low–Level Content
Hide Non-Adjusted Measurements
Turn on Verbose Logging
AUTOMATICALLY DELETE SOURCE FILES ON SUCCESS

This setting will force AudioTools Focus to delete source files associated with any queued Job
that completes. This can prevent file system over–utilization but is also a potentially dangerous
setting.
REMEMBER PROCESSED HOT FOLDER SOURCES

This setting, when enabled, forces AudioTools FOCUS to remember the names of files that have
already been processed in Watched Folder Jobs. This means that, when enabled, a file with a particular name will only be processed once. When disabled, files will be processed regardless of that
named file’s previous history.
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REMOVE FROM WORKBENCH ON START

This setting clears the Workbench each time you restart AudioTools FOCUS.

PROCESS LOW-LEVEL CONTENT

When enabled, this setting will force AudioTools FOCUS to normalize, what FOCUS calls a
“Program Loudness” adjustment, all content including very low amplitude audio. This may raise
the noise floor of the corrected content. When disabled, the application will not normalize content
below -70 dBFS absolute.
In general, this setting should remain disabled…Over the course of an asset’s lifecycle, analog
noise, such as hum, tape hiss, amplifier noise, and other unwelcome content may make its way into
a file. Program Loudness adjusting that noise would make it much louder, often by 40 or 50 dB. The
noise would then be competing with the desired material, with unacceptable results.
HIDE NON-ADJUSTED MEASUREMENTS

When enabled, this setting causes the application to not display any parameters in the Before
measure windows that were not enabled for a Job.

When enabled, non–adjusted metrics are not shown…
TURN ON VERBOSE LOGGING

This setting switches the logging function from the default simplified version, mentioned above,
to a detailed log generated by all Jobs. This logging mode is useful for troubleshooting Jobs that will
not run. The detailed log can also be copied and pasted into a plain text file or e-mail to be sent to
Minnetonka Audio’s tech support department: <ATSSupport@minnetonkaaudio.com>

Details

At lower right is the fourth Quadrant, DETAILS. This Quadrant displays details for whatever is
selected in either the Workbench or the Production Queue.

Workbench Details

When a Job in the Workbench is selected, its details are displayed in the Details Quadrant.

! ��������

Note that AudioTools FOCUS for Loudness Control presets are predefined for each particular loudness control standard. The setting should not be altered if you want your corrected content to
conform to the chosen standard.

������������

Also note that your local loudness control standards, including those in The Netherlands and France,
may deviate from the more universal accepted standards, particularly for short form content.

Page 24

AudioTools FOCUS for Loudness Control •

Workbench Details
METADATA

At the top of the Workbench Details are text fields for Project, Name, Comments, and Created
By metadata. Metadata entered in these fields are saved along with a preset.

! ��������

Note that these fields accept most characters except; &, <, >, ‘, “, ‘, ’, “ and ”. Inclusion of one of these
disallowed characters will corrupt your Job and cause it to stop in an error state.
PRIORITY

The Priority menu controls the order in which Queued Jobs are processed. Under normal circumstances, AudioTools FOCUS for Loudness Control processes Queued Jobs serially, so this
setting has no effect.
However, if multiple Concurrent Licenses are installed (an option for the FOCUS family) or
when AudioTools FOCUS for Loudness Control is running on a host that also has AudioTools
Server installed, then the Priority setting will control how Queued Jobs are processed. When a processing slot is freed, then FOCUS runs the next Queued Job with the highest priority. If all Queued
Jobs have equal priority, then the Queue runs as a first–in, first–out processor, with as many Jobs
running as there are Concurrent Licenses available.
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SOURCE/OUTPUT

For File–Based Jobs, the Source file name and explicit path are displayed. For Watch Folder Jobs,
the Source directory and explicit path are displayed.
PROGRAM CONFIGURATION

The program configuration of your source files needs to be defined. That parameter is set by the
Program Configuration menu.

The Program Configuration menu

All of the standard program configurations are available. The 5.1+2 and the 2+5.1 entries denote
a 6 channel surround program and a stereo program respectively. The 2x2, 3x2 and 4x2 entries
denote multiple stereo programs, while the 4x1 and 8x1 entries denote multiple mono programs.
The 4+4 entry denotes two “quad” or discrete four channel quadraphonic programs, with the Quad
entry denoting a single quad program on the first four channels.

! ��������

Note that this parameter must be set prior to running any Jobs as either unexpected results will be
produced or the Job will stop in an error state.
TARGET LOUDNESS

The Target Loudness setting can be disabled or enabled to force the application to measure and
correct the audio’s Target Loudness. This setting controls Programme Loudness, forcing the material being processed to conform to the chosen international standard ±0.1 LUFS. The principal
loudness parameter used by all loudness control standards, see “Programme Loudness” on page
15 for more information.
The Target Loudness setting uses the entire program to measure its loudness. You can optionally
choose dialog anchoring as an alternative which, depending on the composition of the audio material, may produce subjectively better results. See “Anchoring” on page 16 for information.
MAX SHORT TERM LOUDNESS

When Maximum Short–Term Loudness or MSTL is enabled, AudioTools FOCUS for Loudness
Control will alter the gain of the signal if the measured MSTL value exceeds the threshold setting.
The MSTL setting is typically disabled, because this parameter is not specified in current governmental loudness control standards. Nonetheless, MSTL is able to gauge a useful and often critical metric that can help to control highly dynamic material. See “Short-Term Loudness” on page
16 for more information.
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The EBU specifies that MSTL use a 3000 ms sliding window. When AudioTools FOCUS for
Loudness Control uses MSTL to do specialized loudness processing, it shortens the window in
order to better judge short term loudness trends. The Response Time parameter forces either the
standard 3 second window size or the short window size required by Minnetonka Audio’s proprietary A.I.M. Artistic Intent Management processing for wide dynamic range content.
The Mix parameter is a scaling factor applied to the MSTL setting. At 100%, the MSTL setting
is applied as set. At 50%, half of the user setting will be applied to alter the gain of any window of
time that exceeds the threshold. At 0%, the MSTL is effectively disabled. This is also an A.I.M.–specific setting.
MAXIMUM MOMENTARY LOUDNESS

When Maximum Momentary Loudness or MML is enabled, AudioTools FOCUS for Loudness
Control will alter the gain of the signal if the measured MML value exceeds the threshold setting.
The MML setting is typically disabled because, as with MSTL, this parameter is not specified in
current governmental loudness control standards. Nonetheless, MML is able to gauge a useful and
often critical metric that can help to control highly dynamic material. See “Momentary Loudness”
on page 16 for more information.
The EBU specifies that MML use a 400 ms sliding window. When AudioTools FOCUS for Loudness Control uses MML to do specialized loudness processing, it shortens the window in order to
better judge the near–instantaneous loudness trend. The Response Time parameter forces either the
standard 0.4 second window size or the short window size required by Minnetonka Audio’s proprietary A.I.M. processing for wide dynamic range content.
As with MSTL, the Mix parameter is a scaling factor applied to the MML setting. At 100%, the
MML setting is applied as set. At 50%, half of the user setting will be applied to alter the gain of any
window of time that exceeds the threshold. At 0%, the MML is effectively disabled. This is also an
A.I.M.–specific setting.
TARGET LOUDNESS RANGE

Being essentially a dynamic range metric, the Loudness Range parameter will forces the loudness range of processed material to be contained within the value set by the user. See “Loudness
Range” on page 15 for more information.
TARGET TRUE PEAK

The True–Peak setting determines the maximum allowable true–peak excursion permissible in
the processed audio. See “True-Peak” on page 16 for more information.
FINAL MEASUREMENT

The Final Measurement preferences allows AudioTools FOCUS for Loudness Control to generate
a log file, and to disable the true–peak function. The Create Log File setting forces the application,
when enabled, to generate a log file in the standard CSV format. This file type can be opened in a
text processor or spreadsheet application. The button at right, labeled “…”, opens a file browser dialog allowing you to specify the destination directory for the log file.
The final Job preference is the Disable True Peak switch. As the name implies, this setting allows
you to disable true–peak measurement and adjustment.

! ��������

Note that the true–peak measurement calculation requires substantially more host processing than
other parameters. Unless true–peak limiting is required, disabling this option will reduce processing
time.

Production Details

The Production Details display is largely devoted to “Before & After” metrics.
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Production Queue Details

INTERPRETING THE NUMBERS

AudioTools FOCUS for Loudness Control considers Programme Loudness to be an absolute
value, and will alter the content to within ±0.1 LU, but Maximum Short Term, Maximum Momentary, Loudness Range, and True Peak are maximum values which will only be “hit” if the incoming
signal is above each of those targets. Also, the processing stages are chained, so the amplitude of the
material is modified as it passes through each particular stage.
As an example, suppose you provide some material whose original Programme Loudness is -15
and its MSTL is -10. You set your target Programme Loudness to -23 and target MSTL to -12. The
MSTL limiter, which is situated “downstream” in the signal processing chain, will never engage
because the prior Programme Loudness adjustment stage brings the program’s MSTL value well
below the -12 target. In the DETAILS results, you would see:
Before
—
PROGRAM:
-15
Before
—
SHORT TERM: -10
After
—
PROGRAM:
-23
After
—
SHORT TERM: -18
The Programme Loudness was 8 LU away from its target and, when it was reduced by 8 LU, the
original MSTL of -10 was also gain reduced by 8, resulting in the final MSTL of -10 minus an additional 8 or -18 LU.

File Formats
Unwrapping & Wrapping

AudioTools FOCUS for Loudness Control can parse QuickTime and MXF files. Specifically, it
will handle MXF OP1 and OP1a file types.

Audio Formats

AudioTools FOCUS for Loudness Control can parse common linear PCM file type. These include WAV, BWF and AIFF, at 32 to 384 kHz sample rates along with 8, 16 or 24 bit integer and 32
bit floating point word lengths.
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View Menu
The View Menu provides command to highlight specific aspects of the user interface, as well as
opening an embedded version of this user manual.

Focusing On…
The Focus On commands allow you to maximize individual Quadrants. These commands are
especially useful when screen real estate is limited. The Focus On > All command rebalanced the
four Quadrants so they occupy equal space.

About FOCUS
The About FOCUS command opens the application’s About dialog, which displays the version
you are running. Also shown are the number of concurrent Jobs for which your installation is licensed. See “Priority” on page 25 for more information on concurrent Job licensing.
In addition, the About dialog includes hyperlinks to the Minnetonka Audio web site and to
AudioTools tech support e–mail. See “Turn on Verbose Logging” on page 24 for suggestions on
gathering information prior to submitting a support request.

FOCUS Manual
The application includes an embedded user manual, accessible through the FOCUS Manual
command.
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Exiting The Application
When you quit the application, AudioTools FOCUS for Loudness Control saves the entire Workbench and restores that state the next time you re–launch. The application also auto–saves the
Workbench every 60 seconds in case of a crash. Again, that state is restored on next launch.
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Shortcuts
File Menu
Preferences
Quit

control +. (period)
control + q

Workbench Menu
Start Selected
Start All
Remove Selected
Remove All
Load Workbench…
Save Workbench…

control + s
shift + control + s
control + r
shift + control + r
shift + control + l
shift + control + s

Production Queue Menu
Stop Selected
Stop All
Remove Selected
Remove All

control + t
shift + control + t
control + m
shift + control + m

View Menu
Focus On Workbench
Focus On Presets
Focus On Parameters (Details)
Focus On Production Queue
Focus On All
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control + 1
control + 2
control + 3
control + 4
control + 5
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Troubleshooting
General
Upon encountering an unexpected behavior, the first step is to save your Workbench, then exit
the application and restart as soon as possible. That simple procedure will usually clear up any
problems.
If the problem is repeatable, please make a note of the steps you took to produce the undesirable
result, along with information about your host machine, and the version of FOCUS that you are
running. Then, e–mail that information to tech support at <ATSSupport@minnetonkaaudio.com>.
Our tech support team may ask for additional information and/or specific files to analyze.

Licensing
Before launching AudioTools FOCUS for the first time, you must already have a license residing
on your WIBU CodeMeter stick. Without a license present, AudioTools FOCUS will pop up an
error dialog.

The Licensing Error dialog

You can address this issue in two ways; one is to make sure that you have plugged in a licensed
WIBU CodeMeter stick, then restart the application. If you would like to keep the application running, you can employ the File > Stop Service command. This halts AudioTools FOCUS’ background
process. Selecting File > Start Service will restart the background process and force it to validate
your license.

Access Control
As mentioned earlier, AudioTools FOCUS includes a Windows Service that runs in the background. During installation, you may have needed to grant the MASI AudioTools Service proper
permissions. If not, you may not be able to read or write to some directories, or AudioTools FOCUS,
may not be able to parse or “see” the contents of a Watch Folder. See “Permissions” on page 12
above for more information on configuring the MASI AudioTools Service.
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Appendix
Specifications
Host computer:
- Windows 7 or Windows Server 2003, 2008 or 2012
Supported Media Types:
- PCM: Wave
- PCM: AIFF
- PCM: MXF–wrapped
- PCM: QuickTime–wrapped
Program Configurations:
- One Program, All Channels
- Mono
- Stereo,
- 5.1
- 5.1+2
- 2+5.1
- 5.1+2+5.1+2
- 2+5.1+2+5.1
- 4xStereo
Supported Processing:
- Loudness Measurement–only
- Loudness Range Adjustment (Classic)
- Loudness Range Adjustment (A.I.M./Wide DR)
- Programme Loudness
- Maximum Short–Term Loudness
- Maximum Momentary Loudness
- True–Peak Limiting

Preset Metrics
Loudness Control
PL
Anchor
MSTL
MML
LR
Long Form
		
CALM A/85 - Program Anchor
-24
Program				
		
CALM A/85 - Dialogue Anchor
-24
Dialog				
		
EBU R 128 - Program Anchor
-23
Program
-12			
		
EBU R 128 - Dialogue Anchor
-23
Dialog
-12			
		
ARIB - Program Anchor
-24
Program				
		
ARIB - Dialogue Anchor
-24
Dialog				
		
OP-59 - Program Anchor
-24
Program				
		
OP-59 - Dialogue Anchor
-24
Dialog				
Movies
		
Loudness Range					10
Short Form
		
CALM A/85
-24
Program
-20
-15		
		
EBU R 128
-23
Program
-20
-15		
		 ARIB
-24
Program
-20
-15		
		 OP-59
-24
Program
-20
-15		
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TP
-2
-2
-1
-1
-1
-1
-2
-2
-1
-2
-1
-1
-2
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A
About FOCUS 29
access control 32
activation 7
additional Job features 22
A.I.M. 27
anchoring 16
Appendix 33
audio formats 28
AudioTools Service
configuring 12
Automatically delete Source Files on Success 23
B
benefits 5
C
CodeMeter dongle 7
configuring the AudioTools Service 12
D
Details
Production 27
Workbench 24
Details Quadrant 24
dongle
CodeMeter 7
WIBU 7
E
exiting the application 30
F
factory presets 18
file-driven Jobs 21
file formats 28
audio formats 28
Final Measurement 27
Focusing On… 29
FOCUS Manual 29
G
gating 15
generating your License Request file 7
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getting started with the application 18
H
Hide Non-Adjusted Measurements 24
I
input
audio formats 28
file formats 28
unwrapping & wrapping 28
installation 6
AudioTools FOCUS 6
permissions 12
WIBU 6
interleaved or split mono inputs 21
interpreting measurements 28
J
Job inputs
mono files 21
selecting Job inputs 21
Job output 22
Jobs
logs 22
removing 22
selecting 22
transport controls 22
Job types 20
L
licensing 7
generating your License Request file 7
licensing troubleshooting 32
LKFS 14
logs 22
loudness adjustment presets 19
loudness measurement presets 20
Loudness Range 15
loudness regulation 14
M
Maximum Momentary Loudness 27
Max Short Term Loudness 26
measuring loudness 14
anchoring 16
gating 15
LKFS 14
Loudness Range 15
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Momentary Loudness 16
Programme Loudness 15
Short-Term Loudness 16
supported loudness management standards 16
True-Peak 16
Menu
Priority 25
Production Queue 22
Program Configuration 26
View 20
Workbench 20
Menus 29
View 29
Metadata 25
Minnetonka Audio 5
Momentary Loudness 16
Mono Files 21
N
new Jobs 22
O
Output 26
P
Permissions 12
preferences
Automatically delete Source Files on Success 23
Hide Non-Adjusted Measurements 24
Process Low-Level Content 24
Remember processed Hot Folder sources 23
Remove from Workbench on Start 24
setting FOCUS preferences 23
Turn on Verbose Logging 24
Preset metrics 33
presets
Factory (default) 18
loudness adjustment 19
loudness measurement 20
metrics 33
user-defined 20
Presets Quadrant 18
Priority 25
Priority Menu 25
Process Low-Level Content 24
Production Details 27
interpreting measurements 28
Production Quadrant 22
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additional Job features 22
new Jobs 22
Production Queue Menu 22
Program Configuration Menu 26
Programme Loudness 15
Q
Quadrants
Details 24
Presets 18
Production 22
Workbench 20
quitting the application 30
R
Remember processed Hot Folder sources 23
Remove from Workbench on Start 24
removing Jobs 22
S
selecting Job inputs 21
selecting Job output 22
selecting Jobs 22
selecting the Job type 21
setting FOCUS preferences 23
shortcuts 31
Short-Term Loudness 16
software
activation 7
licensing 7
Source 26
specifications 33
supported loudness management standards 16
T
Target Loudness 26
Target Loudness Range 27
Target True Peak 27
transport controls 22
troubleshooting 32
access control 32
True-Peak 16
Turn on Verbose Logging 24
U
unwrapping & wrapping 28
user-defined presets 20
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user manual
FOCUS Manual 29
V
View Menu 20, 29
About FOCUS 29
Focusing On… 29
W
Watch Folders 21
WIBU installation 6
Workbench
Details 24
Final Measurement 27
Maximum Momentary Loudness 27
Max Short Term Loudness 26
metadata 25
Priority 25
Program Configuration 26
Source & Output 26
Target Loudness 26
Target Loudness Range 27
Target True Peak 27
Workbench Menu 20
Workbench Quadrant 20
file-driven Jobs 21
interleaved or split mono inputs 21
Job types 20
selecting Job inputs 21
selecting Job output 22
selecting the Job type 21
Watch Folders 21
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